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SECTION 1 – INTRODUCTION

___________________________________
An Overview of the ISP-100

The ISP-100 is the first in a line of high quality signal processing products from
Telex Communication’s Merlin� division. Merlin represents a continued
commitment to understanding and meeting our customers needs through the
development of innovative and intuitive solutions.

The ISP-100 is designed with flexibility in mind, providing a powerful tool that
allows you to adapt to ever-changing markets and applications. The utmost in
quality is also a prime directive in the design and manufacture of this, as well as
all future products from Merlin. A versatile platform, utilizing the latest in DSP
technology, allows Merlin to quickly adapt to new market demands and
continually changing improvements and advancements in the semiconductor
industry.

A series of pre-defined, signal path topologies, called QuickMaps � are offered,
which enable the designer to quickly define the system’s processing structure.
This approach allows for a continuation of new processing solutions and/or
variations, providing “market specific” templates to help minimize your design
time, and increase your profit. The introduction of the QuickBUILD � design
software offers the designer or installer the ability to create custom mappings in a
matter of minutes.

Since this single rack space unit can replace a multitude of traditional analog
components, time and money savings are realized in reduced labor costs for wire
harnessing, rack size and assembly, and minimized failure due to connection
solder joints. As a result of this consolidation of processing, overall system
performance and audio integrity is greatly increased.

An ergonomically designed software interface called VUE-IT� provides graphic
control panels with the “conventional” look of signal processors, as well as an
advanced and easy to use filter tool, which graphically displays the configuration
of your filter block settings.

One of the most impressive and unique features of the ISP-100 is the
configurable input/output (I/O). This feature allows the designer or installer to
select between analog input or output modules, and/or a digital input/output
combination module. These modules are two channel units and can be
intermixed between analog and digital, providing a variety of I/O combinations.
The ISP-100 supports a maximum of 4 inputs, with a maximum of eight outputs,
thus offering combinations like 2x4, 2x6, 2x8, 4x4, 4x6, or, 2 in digital x 8 out
analog, and so on. The current series of QuickMaps support most of these I/O
configurations, with more on the drawing board to be released soon.
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Because of our commitment to providing the utmost in audio quality, the
dynamic range of the ISP-100 rivals anything currently on the market. The Audio
Precision 2�, the testing standard for digital audio equipment, resolves signals
down to –125 dBFS; at this level the ISP-100 is still performing exceptionally.

Propagation time is minimized in the ISP-100. No more than two milliseconds of
delay is introduced from any analog input to analog output with  full processing.

The ISP-100 is flexible. A General Purpose Interface (GPI) allows multiple
system configurations to be selected without the need of a PC to control the unit.
This is accomplished through user-supplied contact closures. This interface
allows users to change system settings directly and/or scroll through various
settings.

Introduction to the ISP-100 QuickBUILD � Design Software

The Merlin ISP-100 QuickBUILD � design software is a companion to the ISP-
100 VUE-IT� setup and control software. This software allows a system
designer or installer the ability to create application specific, custom QuickMAPs
in a short period of time. These “mappings”, or audio topologies, can be created
from scratch, or, existing QuickMAPs can be loaded and then modified if you only
require a variation of a previously built map. Modifying existing maps can
obviously save a great deal of time.

When building a system in QuickBUILD�, you will be placing blocks on your
screen that represent the various processing devices available. These are
representations only, and do not contain device control objects. You will not be
able to make control changes until you are running your design in the VUE-
IT� software . Since the purpose of this software is to simply design an “audio
map”, this should not present any problems.

The QuickBUILD � software is a 32 bit application and can only be run on
Windows� 95 or higher operating system. This software is designed to run
independent of the ISP-100 hardware, allowing system designs to be created
prior to receiving hardware. We do however suggest that you test any new
mappings by downloading them into to the ISP-100 hardware prior to installation
for assurance that there are no errors in the QuickBUILD� design. The
QuickBUILD� software will alert you of possible DSP resource errors during the
design phase, but we feel that testing the hardware is a prudent safety
precaution.

An additional net result of the development of this software was a more efficient
use of DSP resources, allowing for additional processing capabilities. Added to
the exceptional features of the ISP-100 hardware, we feel that this combination
will provide you with a powerful and flexible tool to cost-effectively solve many of
your installation needs.

It will be very important to understand the DSP input/output architecture of the
ISP-100 in order to fully utilize DSP resources. Please read the subsequent
section called DSP “Processing Engine” I/O Interconnect .
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SECTION 2 – QuickBUILD � SOFTWARE
INSTALLATION

___________________________________

Minimum Computer Requirements for Running QuickBUILD �

� An IBM� compatible computer with an 80486 DX2 66 (or higher) processor,
running Microsoft� Windows� 95 (or higher) operator system.

� 8 MB of ram.

� 5 MB of available hard drive space.

� 3.5 high-density disk drive.

� Monitor resolution of 640x480, 256 colors.

� A mouse or other pointing device supported by Windows�.

� Communications port with 16550 UART recommended. (Required for VUE-
IT� software only. Not necessary for QuickBUILD � by itself.)

Installing QuickBUILD � on Your Computer

As previously mentioned, QuickBUILD � is a 32 bit application and can only
be run on a Windows � 95 (or higher) operating system .

� Close all programs before installing QuickBUILD software.

� Insert the QuickBUILD installation disk in your 3.5-inch floppy drive.

� From the Windows� 95 desktop, click Start .

� Select Run  from the Start menu.

� Type A:\setup.exe .

� Click the “OK” button.

� Follow the QuickBUILD � software installation instructions as they appear on
the screen.
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SECTION 3 – ISP-100 DSP ARCHITECTURE

___________________________________

ISP-100 Input/Output Capabilities

As mentioned previously, one of the most impressive and unique features of the
ISP-100 is the configurable input/output (I/O). This feature allows the designer or
installer to select between analog input or output modules, and/or digital
input/output combination modules to accommodate specific application needs
without having to pay for unused I/O. These modules are two channel units and
can be intermixed between analog and digital, providing a variety of I/O
combinations. When using analog modules, the ISP-100 supports a maximum of
4 inputs (MIM modules), with a maximum of eight outputs (MOM modules), thus
offering combinations like 2x2, 2x4, 2x6, 2x8, 4x4, and 4x6. If an MDM-1 digital
module is installed in slot 2, a 4x8 I/O configuration can be achieved.

Here is a look at the I/O module bays of the ISP-100. It will be helpful to have a
“mental picture” of the I/O structure of the ISP-100 when designing systems in
QuickBUILD �.

INPUTS/OUTPUTS

Figure 1.

SLOT 1 – Input only (MIM or MDM)
SLOT 2 – Input and/or Output (MIM, MOM, or MDM)
SLOT 3 – Output Only (MOM or MDM)
SLOT 4 – Output Only (MOM or MDM)
SLOT 5 – Output Only (MOM or MDM)

ANALOG AND DIGITAL I/O SLOT CONFIGURATIONS:

2 X 2 Input= SLOT 1      Output= SLOT 5. 2 X 4 Input= SLOT1   Output= SLOT 3, 5.
2 X 6 Input= SLOT 1      Output= SLOTS 3, 4, 5. 2 X 8 Input= SLOT1   Output= SLOTS 2, 3, 4, 5.
4 X 6 Input= SLOTS 1,2 Output= SLOTS 3,4,5.

DIGITAL I/O CARD – SLOT 2 CONFIGURATION:

4 X 8 Input= SLOTS 1,2* Output= SLOTS 3,4,5.

*MDM-1 DIGITAL CARD

Understanding this I/O structure will also be helpful when specifying or ordering
ISP-100 hardware.

SLOT 1SLOT 2SLOT 3SLOT 4SLOT 5

1a    1b2a    2b3a    3b4a    4b5a    5b
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DSP “Processing Engine” I/O Interconnect

The ISP-100’s processing engine is comprised of three Motorola 56004 DSP
chips. There is a specific input/output interconnect between these chips that
needs to be understood before working with the QuickBUILD � software. Here is
a diagram of the DSP interconnects:

(*Slot 2 Can Be Input and/or Output)
Figure 2.

As you can see from the diagram, DSP 1 is responsible for accepting input
signals from slots 1 and 2, inputs 1a, 1b, 2a, and 2b .
DSP 2 is responsible for output on slots  2 and 3, output 2a, 2b, 3a, and 3b .
DSP 3 is responsible for output on slots 4 and 5, output 4a, 4b, 5a, and 5b .

The interconnects between DSP chips are labeled by TX and RX designators.
The “T”  in TX stands for “Transmit” and the “R”  in RX stands for Receive. Each
Motorola 56004 is capable of four inputs, or receive channels, and six outputs, or
transmit channels. They are labeled as follows:

INPUTS: OUTPUTS:
RX0L TX0L
RX0R TX0R
RX1L TX1L
RX1R TX1R

TX2L
TX2R

To simplify the diagram, only the TX designators for DSP 1 and one pair of TX
designators for DSP 2 have been labeled.
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When you begin wiring devices together in QuickBUILD, the software will
automatically choose the appropriate TX and RX path for you. Occasionally you
may have to “force” a connect path and understanding these terms and
interconnect structure will be helpful. This procedure will be discussed in detail in
the Advanced Design section of this manual.



9

SECTION 4 – BUILDING A QuickMAP �

___________________________________

Monitoring DSP Resource Meters

As described in the previous section, the ISP-100 utilizes three DSP chips to
generate the various processing device algorithms. In the QuickBUILD�
software, you will be shown a series of DSP resource meters for each of the
three chips. These meters provide a real-time estimate of DSP resource usage,
thus giving you a guideline on how many devices you can place in a given chip.
An accurate resource accounting may be requested from the “QMap
Information” report found in the “Edit” menu . Keep in mind that the DSP
resource meters are only estimates of DSP resource usage , and all designs
should be periodically monitored in the “QMap Information” report to know that
your design will “fit” within the DSP capabilities of the ISP-100. Here is what the
DSP resource meters look like:

Figure 3.

Figure 3’s meter settings represent your total resources available for all three
chips. (This is what your resource meters look like when you begin a new
QuickMAP.) X, Y, and P are DSP memory resources (measured in words), and C
represents DSP cycles. The “C”  meter, or DSP cycles, will be your most
commonly watched resource. We will discuss X, Y, and P memory in more detail
in the Advanced Design section of this manual. A certain amount of resources
are necessary for the operating system to function, which accounts for the partial
usage of each meter. As a “rule of thumb”, we do not recommend that you
allow your DSP cycles to fall below 100.

When you select  a device to be placed on the screen, you will be given a choice
as to which DSP chip it will reside in. As soon as the device is placed on the
screen, you will immediately see the DSP usage impact of that device. The
devices will be color-coded as to which DSP they reside in. Devices in DSP #1
will be Yellow . Devices in DSP #2 will be Green . And Devices in DSP #3 will
be Blue .
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The Device Menu

You can select a device to be placed on the screen from either the Components
menu in the Menu Tool Bar. (The Component menu can also be accessed by
clicking your right mouse button while your mouse pointer is anywhere on the
white area of the screen.)

Figure 4.

Or devices can be selected directly from the Tool Bar:

Figure 5.

As you can see in figure 5, some of the device names are truncated for space
considerations.

To select a device, simply click on the device with the left mouse button. A dialog
box will appear requesting certain information from you. Most of the time, the
dialog box will be asking which DSP you wish the device to be placed in. We will
examine the various dialog boxes for each device in the next three chapters.
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Selecting and Placing Inputs (Gain)

The first recommended step in building a system is to identify your inputs. The
inputs are linked  to the Gain device in the component menu. When you select a
Gain device, the following dialog box will appear:

Figure 6.

You will first want to select which physical input on the ISP-100 the Gain device
will be linked to. (Refer to figures 1 and 2.) As you recall, slot 1 can be input only,
and slot 2 can be input or output. Therefore your input choices are 1a, 1b, 2a,
and 2b.

Figure 7.

Normally you will start building inputs in that order, so your first selection would
be 1a.

You can rename the Gain device at this point also by typing a new name in the
“Name” window, or you can rename devices at a later point under the device edit
function.

There are two other windows in this dialog box where values can be entered. The
RID (Relative Identification) box and the DSP box. The QuickBUILD� software
will automatically fill in the correct values for you. Under normal circumstances,
you would not alter these values after the software has assigned values to them.
Working with these windows will be discussed in the Advanced Design section.
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After you have chosen an input for your Gain device, click the “OK” button. You
will then see a Gain device block attached to your mouse pointer. This will allow
you to place the device where you want it. When you have chosen a position for
the device, click you left mouse button and the device will remain at that location.
(There is a grid that the devices will lock to.) You can move the device at a later
point if you wish to.

Figure 8.

To move the device, place your mouse pointer over the device, hold your left
mouse button, and move the device.

Selecting and Placing Outputs (Dither)

You may also want to define your outputs in the early stage of design. This is
entirely up to you whether you define them first or at the end of your design.

The outputs are linked to the Dither device. (The Dither device is used to adjust
bit resolution for digital outputs. See the ISP-100 manual for more detailed
information.) When you select the Dither device from the device menu, you will
first see a sub-menu prompting you to place the output in either DSP #2 or DSP
#3 (Figure 9). As you recall from Section Three, DSP 2 handles outputs 2a, 2b,
3a, and 3b, and DSP 3 handles 4a, 4b, 5a, and 5b. It is helpful to “think ahead”
as to how you may want the ISP-100 wired at installation time.

Figure 9.
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When you have made your decision, mouse click on the appropriate DSP. You
will then see this dialog window. This is the dialog window for DSP 2:

Figure 10.

If your system is using analog converter cards and you are building a four input
design, an input card will occupy Slot 2 and therefore you will avoid using outputs
2a and 2b. (Using an MDM-1 digital card in Slot two will allow you to use that port
for both two channels of input and two channels of output simultaneously.)

If your system is two inputs and six or less outputs, we recommend that you
leave slot two “empty”. This will allow you to easily add either two more inputs
OR two more outputs for future system expansion.

The input select box will be automatically set when you wire something to this
output, so disregard this box for now. As mentioned before, you can rename this
device now or edit it later.

As you move your mouse pointer over the various devices on your screen, you
will see the name of that device. This will either be the default name or a name
you have chosen. As you move the pointer over the input and output triangles,
you will see what I/O port they are attached to:

Figure 11.
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Selecting and Placing Processing Devices

 To select processing devices, follow the same procedure as selecting inputs and
outputs, except you will not see any dialog windows*. As you select a device, you
will be prompted to place it in either DSP #1, DSP #2, or DSP #3.

Figure 12.

* The delay device will have a dialog window prompting you to select the maximum delay time for
that device.

At this point you will be placing the devices you need for your specific application
while trying to “fill up” the DSPs for maximum resource usage. You may want to
build your system from input to output, filling up DSP chip #1 first, and then chips
2 and 3 relative to your assigned outputs. Or you may want to build from the
input forward and output backward and meet in the middle. If your design
requires the maximum amount of DSP available, “trial and error” may be
necessary to make full use of all DSP resources.

Editing Device Parameters

To edit device parameters, place your mouse pointer over the device you wish to
edit and “right click” your mouse. You will then see a sub-menu on the screen
that looks like this:

Figure 13.

To edit the device parameters, click “Edit”. The edit windows for each device will
vary depending on that device’s function. Most edit functions will not effect
DSP resources with the exception of the Filter Tool and the Crossovers .
When editing the Filter and Crossover devices, you can choose how many filter
bands reside in each device. The number of filter bands in a device can
dramatically effect DSP resources . Therefore, you may want to try to select the
desired number of filter bands in these devices as you place them on the screen.
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You can always adjust this number at a later time to make your system “fits” in
the given amount of DSP. We will discuss editing these devices next.

1. Editing Filter Tool Parameters

Right mouse click on the Filter device and select “Edit”. You will then see this
dialog window:

Figure 14.

The number of filter bands for each filter device defaults to three. The range of
filters available for each filter is 1 to 10*. To change the number of filters, either
type the value in, or use the up or down arrows to select the number of desired
filters and click the “OK” button. You will then see the DSP Resource meters for
the specified DSP chip adjust accordingly.

The QuickBUILD� software automatically places filter bands in the Y memory of
the DSP. We will discuss selecting X memory in the Advanced Design section.

* 10 filter bands is the largest number that ergonomically fits in a single VUE-IT� Filter Tool
window. If you require more than 10 bands at a given point in your design, place two (or more)
filter devices next to each other.
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2. Editing Crossover Parameters

The Crossover devices in QuickBUILD� will allow you to create filter devices
after each output of that given crossover. This is accomplished in the Crossover
Edit dialog window.

After selecting and placing the desired crossover, right click and select “Edit”. For
this example, we will look at a four-way crossover dialog window:

Figure 15.

If you desire to have a Filter Tool after any or all of the crossover outputs, you
can select the number of bands for those devices here. You can also select
which DSP chip these filters reside in, but there are some rules:

a) If you place your crossover in DSP #1, the filters can be
placed in either DSP 1, DSP 2, or DSP 3.

b) If you place your crossover in DSP # 2, the filters can only
be placed in DSP 2 or DSP 3.

c) If you place your crossover in DSP #3, the filters can only
reside in DSP 3.

This feature can prove beneficial when you are trying to “shuffle” around DSP
resources. The same rule applies regarding Y memory placement as mentioned
in Editing Filter Tool Parameters.
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After you have selected the desired number of filters, click the “OK” button. You
will then see a series dialog windows relating to each crossover output. They will
look like this:

Figure 16.

You will see one of these dialog windows for every output of the chosen
crossover, if additional filters for that output have been selected . (If no
additional filters have been selected for any or all of the Crossover outputs, you
will be prompted for Crossover output designation when you wire the device.)
This allows you to rename that particular filter device. After you click “OK”, you
will then be prompted to place the device where you want it on the screen.

Figure 17.

When you have finished, your crossover device (in this case a 4-way) should
look something like this (Your wire lines may look different. You can select
different line styles later):

Figure 18.
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3. Editing Delay Parameters

Delay times are generated in the ISP-100 by using system memory and NOT
DSP cycles. This is a great advantage over some other products by not wasting
DSP resources for this function. Therefore, when you change delay parameters,
you will not see any impact on DSP resources.

Each DSP chip is capable of a maximum of 2.7 seconds (2700 Ms), for a total
system allocation of 8.1 seconds (8100 Ms). The QuickBUILD� software will
monitor your delay usage per chip and not allow you to exceed this limit. For
example, if you place a 2500 Ms delay in a given chip, the next delay device you
place (in that same chip) will only be allowed up to 200 Ms.

If you did not assign a delay time when you placed your Delay device, or you
want to change that time, right mouse click and select “Edit”. You will see the
following dialog window:

Figure 19.

You can either type in the delay value you want in the Max Delay Time window,
or you can use the “Up and Down” arrows. The arrows will change the delay time
in 50 Ms increments.

In order to explain the Delay Bias, you need to understand some basic
characteristics of analog and digital inputs and outputs. When you are bringing in
an analog audio signal to a digital processor, or sending out a digital signal to the
analog world, that signal must go through an Analog to Digital (A to D) or Digital
to Analog (D to A) converter. The process of converting this signal requires a
certain amount of time, usually under 2 Ms. If all of your inputs and/or outputs are
going through these converters, they will be effected by this time factor evenly.
Therefore the signals will be “time aligned” correctly. If you are co-mingling
analog signals with digital signals within the same system, there will be a delay
discrepancy between these signals, since no time delay is occurring with the
digital signal. In order to have correct time alignment with all of your audio
signals, the digital signal will need to be “artificially delayed” to align with the
analog signal. The Delay Bias is typically used to correct these delay offsets.
Manual adjustment of this parameter will be discussed in the Advanced Design
section of this manual.
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4. Editing Compressor, Limiter, and Gate Side Chain
Parameters

The Compressor, Limiter, and Gate devices in the ISP-100 will accept a “virtual
control voltage” to control or activate its particular function. A common use for
this function would be to “link” two compressors or limiters in a stereo mode so
they function consistently and evenly. This prevents an unbalanced stereo
image. There are many other uses for this function. For example you may want
the presence of a signal in one audio path to gate the signal in a secondary audio
path. This is used many times in emergency paging to override other signals.
After selecting and placing a Compressor, Limiter, or Gate, right mouse click and
select “Edit”. You will see the following dialog window:

Figure 20.

In the Side Chain window, you will be given a choice of all applicable devices
with which you can side chain to. In this case Compressor 1A is side chained to
the Input Selector of 1B and vice versa to establish and even stereo
compression.

Figure 21.
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5. Renaming Devices

You can rename a device at any time. To do this, right mouse click on the
chosen device and select “Edit”. Type the new name in the Name window. (Refer
to Figure 20.)

Moving Devices

You can move a single device in the following manner. Place you mouse pointer
over the that device. While holding down your left mouse button, drag the device
to the new location. Release the left mouse button.

To move multiple devices, place your mouse at a location above and to the left of
the devices you wish to move. Hold your left mouse button down and drag a
“box” over all of the desired devices. Release the left mouse button. You will then
see that the chosen devices have a bold outline. (In this case, all of the devices
from the crossover to the right.)

Figure 22.

To move the group of devices, hold your left mouse button on any of the
highlighted devices and drag them to the new location. Release the mouse
button.

Deleting Devices

To delete a single device, place the mouse pointer over the chosen device and
click your right mouse button. Choose “Delete”. The device will disappear and the
RID for that device will be reallocated.

To delete multiple devices, highlight the desired devices (as described in the
previous chapter). Place your mouse pointer over any of the highlighted devices
and click you right mouse button. Select “Delete”.
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Wiring Devices

To wire devices together, place your mouse pointer over the source device.
Click your right mouse button and select “Route”. A wire emanating from the
source device will then be attached to you mouse pointer.

Figure 23.
Drag the wire to the destination device and left mouse click on that device. The
wire will then be attached.

Figure 24.

Currently the only way to “unwire” a device is to delete one of the devices and
then replace it.

Choosing a Line Style

If you are wiring a source device to multiple destinations, you can choose how
you want those wires to appear. The default in QuickBUILD� is a Straight Center
to Center:

Figure 25.
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To change the line appearance, place your mouse pointer over the source
device and click your right mouse button. Choose “Line Style”. You will then see
this menu of selections:

Figure 26.

If you select “Segmented Center to Center” your lines will now look like this:

Figure 27.
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Wiring the Selector (Router) Device

A Selector (or Router) device allows you to “select” an audio source, for a given
destination path, from multiple sources. To wire a Selector device, drag a wire
from your first source to the Selector and click your left mouse button. You will
then see a menu requesting which input to the Selector you are wiring:

Figure 28.

In this case you will choose “Input #1”. Repeat this procedure for your second
input source going to Select Switch 1, but this time choose “Input #2”. Continue
this procedure for the rest of the input sources making sure you select the correct
input number. (QuickBUILD� will not let you wire two sources to the same input.)
Your Screen will then look like this:

Figure 29.
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In this example you would follow the same procedure for the other three Select
Switches. When you have completed this, you will have a “spider’s web” that
looks like this:

Figure 30.

Note: When you are running VUE-IT � software, only the lines that are
selected will appear. This gives you a surface look at what you router
selections are.
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Wiring the Combiner (Mixer) Device

To wire Combiner (Mixer) devices, follow the same instructions given in the
previous chapter, Wiring the Selector (Router) Device.

Meter Dialog Window

QuickBUILD� will automatically assign output meters in ascending alphanumeric
order. (2a, 2b, 3a, 3b etc.) These meters will appear in the VUE-IT� software
from left to right. If desired, you can reassign the order of these meters from the
“Meter” button in the “Components” menu. The dialog window looks like this:

Figure 31.

When this dialog window is open, the outputs are labeled on the screen. To
reassign these, click the “ReOrder” button. The numbers to the right of each
output (in the center window of the dialog box) will disappear. To create a new
order, click the output you want the first meter to represent. Then click the output
you want the second meter to be. Continue this procedure until all outputs have
been reassigned. Then click “OK”. The meters will now appear in that order when
you are working with this QuickMAP� in the VUE-IT� software.
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Naming Outputs

You can place “name bitmaps” over the output triangles for identification
purposes. To do this, place your mouse pointer over the desired output triangle
and click your right mouse button. You will then see this menu of choices:

Figure 32.

Select the appropriate label for that output. Repeat this procedure for all outputs
you wish to label. When you are finished, this is what the labels will look like:

Figure 33.
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DSP Resource Errors

If you have exceeded any of the resources within any or all of the DSP chips, an
error message will appear in the Resource Information box. There are six errors
that can occur. (A listing of these are shown in figure 35.) The error messages
will be located on the lower portion of the box:

Figure 34.

In this case, I have exhausted all resources for DSP 1. The meters obviously
show no resources available, and you can scroll through all six errors using the
up and down arrows (figure 34). As we mentioned in the Monitoring DSP
Resource Meters chapter, the Resource Information box is an estimate of
used and/or remaining DSP resources . Your Information box may not show
any errors when in actuality an error could be occurring. An accurate
accounting of DSP resources can be found in the “QMap Information”
window found in the “Edit” menu . This window will give you detailed
information about all parameters of the QuickMAP you are building. (This window
will be discussed in more detail in the next section.) Here is what the DSP
resource portion of that window looks like:

Figure 35.

If you are approaching low meters in the Resource Information window, check
the QMap Information report to make sure no errors have occurred. If any errors
have happened, you will need to work with your system design to correct them.
This may be as simple as lowering the number of filters in a Filter Tool or moving
a device to a different DSP.
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If you try to perform the “Save” or “Save As” function and there are resource
errors, you will see the following warning screen:

Figure 36.

You will need to correct these errors before you can properly save your design.

Note: The QuickBUILD � software will allow you to save your design to file
with errors in the design. This allows you to suspend work on a design and
reopen it later.

Wiring Errors

It can be very easy to forget to wire a device, especially if the devices are placed
close together. Occasionally you may want to check the QMap Information
window. If there are unwired inputs, they will show up in the “Path Delays”
section:

Figure 37.
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If you try to perform the “save” or Save As” function and there are unwired
devices, you will see the following warning window. Clicking “Details” will give
you a list of unwired devices:

Figure 38.

You will need to correct these wire problems before you can properly save your
design.

Delay Compensation

QuickBUILD� will calculate and correct any delay alignment discrepancies
between audio paths if you choose for it to do so.

You can tell the software at any time generate delay compensation by choosing
“Delay Compensation” from the “Edit” menu. A � will appear next to “Delay
Compensation” indicating it is turned on.

If you have not selected this and try to save your file, you will see the following
prompt:

Figure 39.
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Delay Compensation will impact DSP resources, so check your QMap
Information report to make sure you are still within DSP resource limits.

Saving and Opening .qms Files

The file extension for QuickMAP� files is .qms. Saving your QuickBUILD�
design as a QuickMAP� is a standard Windows� procedure, but you may see
some prompts that have been described in the previous chapters. If you don’t
understand these prompts, please review these chapters.

We recommend that you save your file early and often. This software is still
under Beta testing and an occasional “crash” may occur. To save your design for
the first time, click “Save As” in the “File” menu. You will then be prompted to
name your design. Since the VUE-IT� is a 16-bit application, it can be run on
Windows� 3.1 or 3.11. These operating systems only support 8 character file
names. If you think that your file may at some point be running on one of these
systems, you may want to limit your file name for easier clarification. If you know
that it will only be running on Windows� 95 or higher, you may use a longer file
name.

QuickBUILD� files default to being stored in the “C:\Programs\Maptool”
directory. To open these files in your VUE-IT� software, they will need to be
moved to the correct sub-directory in VUE-IT�. Unless you have installed VUE-
IT� in a different directory, the sub-directory will be “C:\Programs\Vue-it\Isp-
100\Qmaps”. You can save your files directly to this directory if you wish. To do
this you must define this path in the “Save” or “Save As” dialog window.

To open files directly from VUE-IT�, you must define the path mentioned in the
previous paragraph in the "Look in” window in the “Open File” dialog box.
Otherwise files will default to be opened from the QuickBUILD� Maptool
directory.
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SECTION 5 – DOCUMENTING YOUR SYSTEM

___________________________________

Defining System Description

When you have completed your system design, you will want to create a “system
description”.

When you create a new project in the VUE-IT� software, you will be shown a
menu of QuickMAPS� to choose from.

Figure 40.

The “Name” represents the file name you gave your design when you saved it.
The “I/O Configuration” is automatically generated from the design itself, and
“Create” and “Modify” are automatically time and date stamped.

The “QuickMAP Description” window is an area that can give you very detailed
information about that specific mapping. This will be very helpful, especially if you
have created numerous qms files, or job specific QuickMAPS�. This description
is defined in the QuickBUILD� software.
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From the “Edit” menu, choose “QMap Description”. You will see the following
window:

Figure 41.

Type the description for your map in 255 characters or less. When you have
finished, click “OK”. This description will now be attached to your QuickMAP�.
You can edit this text at any time by following the same procedure. This “text
block” acts like any word processor, allowing you to copy, paste, and delete
sections.
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Printing System Resources and Device Usage

You can view at any time detailed information regarding your design. The
QuickBUILD� software automatically provides this information for you. To view
it, choose “QMap Information” from the “Edit Menu”. You will see the following
window:

Figure 42.

You can scroll down the page to view the information, or print it out. To do so,
simply click the “Print” button.

Printing System Block Diagram

You can also print a block diagram of your system for your records, or to fax to a
client. This printing will indicate some of the variable parameters such as number
of filters in a filter tool, and maximum delay time in a delay device.

To print your block diagram, choose “Print” from the ‘File” menu.

Note: Some designs may print better using the “Landscape” setting found in your
printers “Properties” settings. You may have to experiment for best results.
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SECTION 6 – ADVANCED DESIGN

___________________________________

UNDER CONSTRUCTION
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